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Preliminary remarks
Intended uses The CAMAT ® Vision sensor is used for recording and evaluation of video signals. It was

developed for industrial measuring and testing procedures for real-time applications. Pro-
grams can be edited on the video display, saved internally or run manually or by external
initiators. Input and output signals are linked across digital interfaces to system features.

The operating conditions and safety instructions established in this handbook must be
observed. If you wish to use your CAMAT for another purpose, then we are happy to pro-
vide support in defining the necessary configurations. Please notify your supplier.

Exclusion of
liability

We guarantee this product to be free of defects as described in our advertising, in the
product information published by us, and in this reference handbook. Any additional prod-
uct properties are not included thereunder. We assume no responsibility whatsoever for
the financial feasibility or error-free operation of the device when used for a purpose other
than that defined in the section on "Intended uses."

Claims for damages are generally not allowed, except after presentation of evidence of
gross, intentional negligence on the part of the manufacturer, or failure of warranted per-
formance. If the product is used in environments for which it is not suitable or which do not
correspond to the usual state of engineering, then we are not responsible for the conse-
quences. Furthermore, we are not responsible for damages to functioning systems
located near the product, when such damages are attributable to the improper operation
of the product or errors in the operating instructions.

We reserve the right to make changes without providing separate notice.

In no case do we accept responsibility for any ancillary or follow-on damages or lost earn-
ings arising from the activities relative to this handbook, specifically when the potential for
such damages was referenced and would have to have been known to you.

We are not responsible for infringement of patent rights and other rights of third parties
outside of the Federal Republic of Germany.

Copyright © Copyright Vision & Control GmbH and FiberVision GmbH. All rights reserved.

Neither this publication nor parts thereof may be copied or provided to third parties with-
out the express, written consent of Vision & Control GmbH or FiberVision GmbH. Hand-
books are provided solely for personal use.

Trademarks All trademarks or registered trademarks used in this publication are acknowledged as the
property of their owners.

Safety
instructions

Important information and instructions for the safety of personnel and equipment will
appear in the handbook as indicated below:

Caution:
Important instructions; failure to observe them may result in damage to equipment.

Note:
Special remarks.
CAMAT ii 10.03.1999
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Safety instructions
Safety instructions
0

Caution:
Do NOT disconnect the CAMAT power supply during non-volatile saves! Potential loss of
data and damage to the CAMAT!
If this operating error occurs, the CAMAT must be returned to the manufacturer for repair.

Caution:
Voltages greater than 40 V can destroy the digital inputs and outputs.

Notes
After unpacking
Carefully unpack the CAMAT and check the contents for completeness and any possible trans-
portation damage. We are only liable for such damage if you report it immediately and before
initial operation of the CAMAT.

Before operation
Read the reference handbook carefully before you take the CAMAT into operation and follow
all instructions and requirements. Only perform the instructions if you understand them.

Repair of the CAMAT
Repair activities and opening of the CAMAT housing may only be performed by the manufac-
turer or authorized firms. Violation of these provisions will void the warranty.

Modification of the CAMAT
The customer shall be responsible for any unauthorized modifications to the CAMAT. Any such
modifications will void the manufacturer’s warranty.
10.03.1999 CAMAT iii
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1.1 General Information

0

What is
CAMAT?

CAMAT is an intelligent Vision-Sensor for industrial measuring and testing procedures
running in real-time. All jobs can be programmed directly in the CAMAT and verified on the
video monitor.

CAMAT includes all functions necessary for preparing, revising, testing and running pro-
grams.

Required operator capabilities
Programming experience is not required. But training is recommended.

Note:
Before preparing your own programs, you should get an overall impression of the
CAMAT modules and read through this handbook.

Available
languages

The user can choose among the following six languages for operation of the CAMAT:
• English  

• German
• French
• Spanish
• Portuguese
• Italian

Applicability The reference handbook
• applies to Vision-Sensors with the CAMAT designation
• is intended for CAMAT users, i.e., persons using it to handle test jobs
• describes the CAMAT modules and their potential applications
• makes it possible to prepare the programming and adjustment of individual modules as

part of an overall training program

This reference handbook is not a substitute for the training program.

Please direct any questions going beyond the scope of this reference handbook to your
supplier.

Contents of
the Reference

Handbook

Part 1: Introduction
The introduction pertains to:
• Safety instructions
• Fundamentals of the Handbook and the CAMAT
• Operation of the hand-held control device and of the control elements on the

video display
• Preparation of programs
• Execution of programs
• Interfaces
• Accessories
• Technical data
CAMAT 1 – 2 02.02.1999
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Part 2: Software Structure
This part contains:
• a chart showing the menu structure
• a chart showing the program structure
• the possible CAMAT operating modes: Edit mode and Run mode
• preparation of a program
• description of recurring menus:

Program menu, Module menu, Window menu

Part 3: Configuration
Describes the options menu for program default setting.

Part 4: Modules
Describes the incorporation of modules in programs.

Part 5: Appendices
This part contains:
• Tips on troubleshooting
• Index
• Glossary
CAMAT 1 – 302.02.1999
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1.2 Programs and Modules

CAMAT
Software

CAMAT contains an integrated program editor. Its operation requires a separate control
device. Program development and testing can be tracked on the video display.

Programs
(Program list)

Programs consist of a sequence
of modules. The CAMAT can
save up to 15 programs simulta-
neously with up to 15 modules
each. But only one program can
be executed at a time.

Programs are displayed in the
program list.

Note:
New program names are generated automatically. The new version number is always
incremented by 1, i.e., it is one greater than the last version number.

Modules
(Module list)

The Modules:
• contain measuring tasks
• contain one instruction each
• can be arranged in random

order
• are executed in sequence,

from top to bottom
• during their execution, they

evaluate results by using the
parameters/tolerances
defined in their creation

The following modules are available:

Program list

Module list

Module Function
Picture module Image recording
Light module Average brightness in the test window
Area module Checking the number of pixels in the test window using a default

gray scale (pixel counter)
Angle module Angle checking
Circle module Diameter and eccentricity check of a circle
Edge module Searches the position of an edge
Length module Length check
Pattern module Searches the position of a structure
Result module Evaluation and output of results
CAMAT 1 – 4 02.02.1999
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1.3 Control Elements and
Conventions

0

Foreword This section covers some basic elements for operation of the CAMAT and explains the
notation and conventions used in the handbook. The elements and procedures are
explained briefly.

Operating keys
on the

Control unit

Nomenclature in
handbook Meaning

(Esc) Cancels an action or cancels the input
Also corresponds to the [Cancel] button in the editor

(Enter) Confirms an action or input
Also corresponds to the [OK] button in the editor

(Cursor up)
(Cursor down)

Up/down movement within lists.
Moves shifters up/down in silder tabs
Moves windows up/down
Changes size of windows

(Cursor left)
(Cursor right)

Switches to left/right shifters in silder tabs
Moves windows left/right
Changes size of windows

(Middle button) Changes sign in the Results table.
See Section 4.9 „Result Module“.

(F1) Displays the overlay picture (sensor window, program name)
in Run mode. See Section 2.3 „Run Mode and Edit Mode“

(F2) –

(Esc)

(F1)

(F2)

(Enter)

Cursor buttons

serial cable

(Middle button)

for the control unit
CAMAT 1 – 502.02.1999
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Dialog buttons

in the Editor

Dialog buttons in the editor are displayed as follows:

Slider tabs
in the Editor

Types of Slider tabs
There are three types:
• Type A: for fine-tuning of nominal values and tolerances
• Type B: for setting of threshold/values without tolerance
• Type C: for setting the dimensions of the calibration element during calibration

Structure of slider tabs
Slider tabs:
• can contain one or three shifters
• indicate the values/tolerances currently in effect
• indicate the dimensional unit
• indicate the meaning of each shifter

(Min / Value / Max / 100x / 1x / 0.01x etc.)
• allow changes in values

Representation in
handbook Meaning Example in

editor
[�Function] leads to additional windows/actions:

• to the program list
• to submenus
• to slider tabs for setting of

parameters and tolerances
• to confirmations (OK/yes/no)

[ Function] Toggles the options:
✓ = active
❏ = inactive

[Function] denotes direct actions
• for editing on the video display
• for testing a module
• to confirm/to cancel- to open/close

windows

✓

lower
tolerance

upper
tolerance

Nominal

(min)

value

(max)

set
values

Meaning of
the shifter

Nominal value/

Dimensional unit

set
value

Meaning of
the shifter

Hundreds
(x100)

Single values
per shifter

One’s
(x1)

Hundredths
(x0.01)

Total value
from

single values

(value)

Dimensional unit

Meaning of
the shifter

Type A Type B Type C

(value)

threshold

Dimensional unit
CAMAT 1 – 6 02.02.1999
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Special properties of Type-A Sliders
Type-A Sliders can be adjusted based on the video display.

In many cases a default setting can be made with the dialog button [Learn], before fine-tuning
with the slider.

The nominal value, the upper tolerance and the lower tolerance:
• are determined automatically for each module during the learning process
• are each represented by a shifter in the slider tab
• can be changed with the shifters

Note:
If a shifter for the nominal value is moved, then the shifters for the tolerances will also be
moved.

Settings of parameters with Sliders
Parameters can be set as follows:

1 For type-A and type-C ONLY: Select the shifter:
• Highlight the desired shifter with cursor left/right on control unit

2 Move shifter up or down:
• Use cursor (up/down) on control unit to move the selected shifter.
• Changed values/tolerances are displayed numerically.
• The changes for several sliders can be monitored on the video display.

3 Save settings:
• Press (Enter) on the control unit.

4 Discard setting:
• Press (Esc) on the control unit.
CAMAT 1 – 702.02.1999
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1.4 Basic Procedures

Editing the
Program

Description in the handbook
… Select / delete / change program, etc.

… Edit program

Brief description
Program menu > [�Program Function] > [Program] > [Save]

Explanation
• [�Program Function] …Function in the Program menu
• [Program] …Program in the program list

Procedure
1 Call up the Program menu: See Section 2.5 „Program Menu“.

2 Select function to run:
• Click on button: [�Program-Function] in the Program menu.
• The bar-cursor presented in reverse video, switches to the program list.

3 Select [program]:
• Move the bar-cursor with the buttons (cursor up/down) on the control unit.

4 Start the function:
• Press the (Enter) button on the control unit.
• Follow any notes/prompts on the video display.

5 Save:
• Non-volatile save with [�Save] from the Program menu.

Editing the
Module

Description in the handbook
… Insert / change / delete the area / light / circle module etc.

… Edit the module…

… Call the module editor

Brief Description
Program menu > [�Edit] > [Program] > Module menu > [Module function] >
[Module] > [Module editing] > [Save module] > [Save program] > [Save]

Explanation
• [Program] …program in the program list
• [Module function] …function in the Module menu
• [Module] …module to be edited
• [Module edit] …Edit menu for the module to be edited
• [Module save] …save directly from the Edit menu of the module being edited
• [Program save] …save in the Module menu
CAMAT 1 – 8 02.02.1999
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Procedure
1 Call the Program menu: See Section 2.5 „Program Menu“.

2 Select the [�Edit] function:
• Click on the [�Edit] button in the Program menu.
• The bar cursor displayed in reverse video, switches to the program list.

3 Select the [Program]:
• Move the bar cursor with the buttons (cursor up/down) on the control device.

4 Switch to the Module menu:
• Press the (Enter) button on the control device.

5 Select function to run:
• Click on the [Module function] button in the Module menu
• The bar cursor displayed in reverse video, switches to the module list.

6 Select [Position of the module]:
• Move the bar cursor with the buttons (cursor up/down) of the control device.

7 [Module edit]:
• Press the (Enter) button on the control device.
• Editor for the specific module is called.
• Edit the module with the available functions.

8 [Module save]:
• Press the (Enter) button on the control device.
• Accept the Save with the [YES] button.
• Exits editor for the specific module and returns to the Module menu.

9 [Save program]; saves the opened program:
• In the Module menu click on [OK].
• Accept the Save with the [YES] button.
• Editor returns to the Program menu.

10 Saving:
• Non-volatile save by using [�Save] from the Program menu.

Saving
Caution:
Do NOT disconnect the CAMAT power supply during non-volatile saves!
Potential loss of data and damage to the CAMAT!
If this operating error occurs, the CAMAT must be returned to the manufacturer for repair.

Module saves take place in three steps. If one of the steps is missing, then settings or param-
eters can be lost:

1 Saving the edited module when leaving the editor of the specific module.

2 Saving the edited program when leaving the Module menu.

3 Non-volatile saving in the Flash-ROM in the Program menu.
CAMAT 1 – 902.02.1999
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1.5 Editing the Programs

Configuration The CAMAT is configured to the optimum setting for the scene to be tested (calibration) and
is adjusted to the requirements (e.g., language).

• See Section 3.1 "Options menu".

Creating a
Program

A program structure can be produced with [�New] in the Program menu. The program struc-
ture contains the Picture module and the Result module.
• See Section 2.4 „Creating a Program“
• See Section 2.5 „Program Menu“

Picture
Recording

The picture recording takes place with the Picture module. It is always located at the begin-
ning of the program.

1 Switch to the Module menu.

2 Call the editor of the Picture module with [�Edit] > [Picture].
3 Choose whether or not a flash is needed for the picture recording.

4 Position the test object in the live picture.
5 Adjust contrast on monitor picture.
6 Exit the live picture mode by pressing any key.

7 Record a memory picture with [Test].
8 Exit Picture module with [OK] and save.

A picture will be taken of the particular scene and saved in the picture memory.
The other modules can be configured by using this picture.

• See Section 2.6 „Module Menu“.
• See Section 4.1 „Picture Module“.

Inserting and
Adjusting of

Modules

When editing the modules, parameters are defined, options selected, results for subsequent
modules are interim-saved or links are established to results of other modules.

The modules are inserted by the operator into the program and adjusted to the scene.

1 Switch to the Module menu.

2 Call the editor of the desired module with [�Add] > [Module name].
3 Tag the position where the new module is to be inserted:

The new module will be inserted.
4 Adjust the parameters and run the Learning process:

This step includes the determination/testing of parameters on the sample object and the
definition of permissible deviations in tolerance.

5 Use [Test] to test the module.
6 Press [OK] to exit the module and save.
7 Insert additional modules:
• See Section 2.6 „Module Menu“
• See Sections 4.2 „Light Module“ to 4.8 „Pattern Module“.
CAMAT 1 – 10 02.02.1999
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Defining the
Evaluation

The evaluation will proceed with the Result module. This module is always located at the end
of the program.

1 Switch to the Module menu.

2 Call the editor of the Result module with [�Edit] > [Result].

3 Define links of the results for the individual modules.
4 Define the display option for the video display.
5 Test the module with [Test].

6 Exit the Result module with [OK] and save.

The overall result of the program:

can be GOOD, BAD or ERROR
• is ALWAYS output in real time via the digital outputs--in addition to any display of video

image
• See Section 2.6 „Module Menu“.
• See Section 4.9 „Result Module“.

Program Test
and

Optimizing

Strategy
1 New programs are initially tested with the picture, taken at optimum settings, for the partic-

ular scene located in the picture memory.

2 The program is then optimized by adjusting the potential boundary conditions for the scene
(brightness, location, dimensions, etc.) and if necessary, by skillful corrections to the
parameters of the module.

Testing of Modules
To test the parameter settings for a particular module, use:
• [Test]-button in the menu of the particular module (during Edit)
• Results fields (GOOD/BAD) in the lower, right region of the display (in Edit mode)
• 1 Symbol each (GOOD/BAD) for each module (except Picture module and Result module)

on the video display during program execution (Run mode)

Testing of Programs
To test the programs, use:
• one symbol for the overall result (good/bad) on the video display during program execution

(Run mode)
• digital output signals (good/bad/error) during program execution (Run mode)
• the dialog button [�Update] in the Program menu (in Edit mode)

Save All changes to modules, programs and to the configuration must be saved.

If programs, default settings and the calibration are to be non-volatile saved in the Flash
EPROM, then the save must ALWAYS occur from the Program menu with [�Save].
CAMAT 1 – 1102.02.1999
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1.6 Running the Programs

0

Readying the
CAMAT for
Operation

1 Use the video cable to connect the video monitor to the CAMAT.

2 Connect the monitor to the power supply and turn it on.
3 Use the serial cable to connect the control device to the CAMAT.
4 Connect the cable for digital inputs and outputs according to the particular application.

5 Connect the CAMAT power supply

Autostart Programs stored in the CAMAT can be started with the Autostart function:

1 Switch on the CAMAT or reset it by switching the power supply on/off:
The CAMAT will automatically start the program saved in the Flash ROM and last running
in the Run mode.
• See Section 2.3 „Run Mode and Edit Mode“

Note:
If no program is saved in the CAMAT, then CAMAT will go into Edit mode. To create a
program, see Section 2.4 „Creating a Program“.

Manual Start Use manual start to test the programs, to create programs and for laboratory apparatus:

1 In Run mode, press (Esc) on the control device and hold it down until the current program
run is completed.
• The CAMAT switches to Edit mode.

2 Start the program manually from the Program menu with [�Run].
• See Section 2.5 „Program Menu“.

Switching
Programs by

External
Initiator (PLC)

If the CAMAT is to be integrated into a process, then use program switching by external
initiator.

With a running program, an external initiator can select a new program from among six possi-
ble programs. Selection proceeds via the digital inputs of the CAMAT. See also the Selection
Table below, and Section 1.7 „Interfaces“.

Selection Table (Digital Inputs In1, In2, In3)

Po
s.

In
1

In
2

In
3 Meaning

0 0 0 0 Start the selected program
(1) 0 0 1 Select program with smallest number in the program list
(2) 0 1 0 Select program with the second-smallest number in the program list
(3) 0 1 1 Select the program with the third-smallest number in the program list
(4) 1 0 0 Select the program with the fourth-smallest number in the program list
(5) 1 0 1 Select the program with the fifth-smallest number in the program list
(6) 1 1 0 Select the program with the sixth-smallest number in the program list
7 1 1 1 Cancel the active program and return to program list
CAMAT 1 – 12 02.02.1999
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Program list
The first selectable program has the smallest program number (in the figure below:
Prog_006). The sixth selectable program has the sixth-smallest program number (in the fig-
ure: Prog_014).

Only one of the six programs with the smallest program numbers can be started - regardless
of its position in the program list.

Note:
In order to start a program with a higher program number, you must delete programs with
smaller program numbers until the number of the desired program is included in the six
smallest program numbers.

Start Programs by External Initiator
Each of the six programs with the smallest program numbers can be started from an external
initiator (e.g., PLC) be setting the inputs In1 to In3 to a particular potential.

The following steps are required:

1 Switch the potential to the inputs to [1 1 1] (see Pos. 7 in the Selection table).
Any currently active programs will be terminated. The CAMAT is now ready to select one
of the programs from Pos. (1) - (6) for start.

2 Switch potential to the inputs according to the Selection table [Pos. (1) - (6) in the Selection
table]. The program corresponding to the applied potential, is selected.

3 Switch the potential to the inputs to [0 0 0] (see Pos. 0 in the Selection table).
The selected program will be started.

1 1 0

1 0 1

1 0 0

0 1 0

0 1 1

0 0 1

Potentials of
the digital
inputs

(see
selection table)

* = programs
without external

In
1

In
2

In
3

(1)

In1, In2, In3

start

(2)

(3)

(5)

(6)

Program number

*
*

*
*
*

(1) - (6) = externally selectable programs

(4)
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1.7 Interfaces

Overview
of the Interfaces

The CAMAT has the following interfaces:
• Digital inputs and outputs (Digital I/O)
• Voltage input (DC-In)
• Output to the control device (RS-232)
• Video output (Video-Out)

Digital
Interfaces

Background
The digital inputs/outputs are connected by a 10-pole Hirose plug. The PLC-compatible inputs
(12 V to 24 V gain, Plus is switched) contain an inlet circuit breaker. The input current when
operating at 24 V is 50 mA.

A logical high-signal will definitely be recognized at an 8 V threshold. At this voltage, a current
of 1 mA will flow.

The digital inputs are optically isolated.

The digital outputs are likewise optically isolated. The output of the optical coupler is con-
trolled by a MOSFET, which, in turn, switches the 12 V to 24 V.

Wiring diagram of digital interfaces (example)

Video-Out Digital I/O
DC-In

RS-232
Control unit

Signal Pin No. Signal Pin No.

OUT0 4 IN0 9

OUT1 3 IN1 8

OUT2 2 IN2 10

OUT3 1 IN3 7

GND IN 5 24 V IN 6 Digital Interfaces
(view of the CAMAT housing)

8

OUT0

OUT1

OUT2

OUT3

IN0

IN1

IN2

IN3

PLC
CAMAT

Program
selection

System O.k.

Ready/Busy

Good/BadLighting

Trigger

Event
(e.g. switch,
photoelectric
barrier signal)

realease (trigger)

flash
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Digital Inputs Caution:
Voltages greater than 40 V can destroy the inputs.

• Operating voltage: 12 to 24 V
• galvanically isolated with optical couplers
• Input current: 5 mA
• Response threshold: 8 V
• internal signal hesitation: about 150 µs

Program switching by external initiators
See Section 1.6 „Running the Programs“.

Digital Outputs Caution:
Voltages greater than 40 V can destroy the inputs.

• Operating voltage: 12 to 24 V, externally carried maximum voltage
• Type: galvanically isolated, with optical couplers, p-channel MOSFET
• Switching potential: +12 V or +24 V switched
• Current: 150 mA per output. ATTENTION! Currents over 500 mA can destroy plugs and

cable.
• Switching power: max. 3.6 W
• Protection against inductive loads: Reverse diode
• Resistance when switched on: < 0.6 Ohm

Switching the outputs as a function of the program result
See Section 4.9 „Result Module“.

Triggering the Flash
See Section 4.1 „Picture Module“.

Signal Pin No. Use Type of control

IN0 9 Input trigger flank-controlled L > H

IN1 8 Skip to program list and start pro-
gram in CAMAT by external control
(PLC); see Section 1.6 „Running
the Programs“"

level-controlled

IN2 10

IN3 7

Signal Pin No. On/high = 1 Off/low = 0 Type of control

OUT0 4 System OK (fatal) error level-controlled

OUT1 3 CAMAT Ready CAMAT Busy level-controlled

OUT2 2 Measured result Good Measured result Bad level-controlled

OUT3 1 Trigger flash — flank-controlled L > H
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Voltage Input

Any possible reversing of poles of the power supply -
if the power comes from an PLC power supply -
is prevented by a polarity reversal diode. It is important that both the external power supply is
connected to the outputs (12 to 24 V) and to GND of the PLC power supply.

Output to the
Control unit

Video Output The video output is designed as a BNC-jack. The provided monitor should be connected to the
video cable.

Note:
Several video monitors will display only about 95% of the video image. This is not suffi-
cient for the CAMAT. Suitable monitor models can be obtained from your system manu-
facturer. Underscan monitors are also suitable.

Signal Pin No. Signal Pin No.

Power 12 V 1 Power GND 5

Power 12 V 2 Power GND 6

Reset SGN 4 Reset GND 3
Power cable
(View of the CAMAT housing)

Signal Pin No. Signal Pin No.

V24 RxD 3 V24 RTS 6

V24 TxD 2 V24 GND 5

V24 CTS 1 V24 +12V 4 RS-232-interface
(View of the CAMAT housing)
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1.8 Cables

Digital-I/O
Cable

• Cable provided with 10-pole HIROSE jack on one
end

• Cable shielded with tinned copper braid
• Shielding of plug with solid crimp connection to

plug housing
• Outside diameter 6.8 to 7.2 mm
• Temperature range –15 to +70°C

Power cable • Cable provided with 10-pole HIROSE jack on one
end

• 4-wire cable, shielded with tinned copper braid
• Shielding of plug with solid crimp connection to

plug housing
• Outside diameter 3 to 6 mm e.g. LiYCY-0.25
• Temperature range –15 to +70°C

AC/DC-converter:
• Input: 100 -240 V AC/0,2 A, 47-63 Hz
• Output: +12 V DV/0,8 A

Signal Pin No. Cable colour

OUT0 4 white

OUT1 3 brown

OUT2 2 green

OUT3 1 yellow

IN0 9 gray

IN1 8 rose

IN2 10 blue

IN3 7 violet

24 V IN 6 red

GND IN 5 black

PLC cable
(View of the CAMAT housing)

Signal Pin No. cable colour

Power 12 V 1 green

Power 12 V 2 yellow

Power GND 5 white

Power GND 6 white

Reset SGN 3 —

Reset GND 4 —

Power cable
(View of the CAMAT housing)
CAMAT 1 – 1702.02.1999



Introduction
1.8 Cables

C A M A T R E F E R E N C E H A N D B O O K

1

Serial cable • CAMAT-side cable end: 6-pole HIROSE-plug

• Control device cable end: 9-pole DSUB-jack
• Cable shielded with tinned copper braid
• Shielding of plug with solid crimp

connection to plug
• Outside diameter 4.8 to 5.2 mm

e.g. LiYCY-0.25
• Temperature range –15 to +70°C

Note:
The serial connection cable is a standard 2.5 m long. A list of suitable cables/cable man-
ufacturers is available from the CAMAT supplier.

BNC-BNC-Mon-
itor cable

• two-end BNC-plug
• 75 W-cable (e.g. RG 59)
• outside diameter 5.5 mm
• Temperature range –15 to +70°C

Signal Pin No. Cable colour

V24 RxD 3 white

V24 TxD 2 brown

V24 CTS 1 green

V24 RTS 6 yellow

V24 GND 5 gray

V24 +12V 4 rose

RS-232-cable (View of the CAMAT housing)
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1.9 Technical Data

Operating
conditions

• Operating temperature –5 to 45°C, relative humidity 80%
• Shock acceleration <70 g
• Vibration <7 g (11-200 Hz)

Interfaces • Power supply 12 V DC ±20% not regulated, about 600 mA
• 1 × serial V.24 (RS-232)
• 4 digital inputs

(12…24 V, optically isolated)
• 4 digital outputs

(150 mA each, optically isolated)

Physical
properties

• Dimensions 117 × 50 × 45 mm² (without lens)

• Weight, about 350 g
• Lens connector: C-mount
CAMAT 1 – 1902.02.1999



Introduction
1.9 Technical Data

C A M A T R E F E R E N C E H A N D B O O K

1

Hardware • Sensor: 740×580 SONY, 1/3" CCD b/w, 8-bit-ADU with Digital Clamping

• Signal processor: Analog Devices ADSP 2181
• Video output: BNC b/w
• Memory: 2 MB Flash ROM
• 8 MB DRAM
• min. close time: 1/10,000 s
• Picture memory: 1
• Processor clock speed: 40 MHz

Other • external control by initiator (PLC):
• Cancel programs
• select a program with the smallest program number from the 6 programs
• start selected program

• flash control if needed
• clock control via trigger input, if needed
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2.1 CAMAT Menu Structure

0

Program
Menu

Module
Menu

Picture Menu
(Module Editor)

Area Menu
(Module Editor)

Angle Menu
(Module Editor)

Circle Menu
(Module Editor)

Edge Menu
(Module Editor)

Length Menu
(Module Editor)

Pattern Menu
(Module Editor)

Result Menu
(Module Editor)

Options
Menu

Window Menu
(Window Editor)

general functions for programs

Run Mode

P-Window Menu
(P-Window Editor)

Pattern Submenu
(pattern recognition)

Edit Mode

Light Menu
(Module Editor)
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2.2 CAMAT Program
Structure

Basic Structure
of Programs

0

0

Program

image grab
Picture Module

evaluation
Result Module

language of user interface

calibration factor Initial setting
is valid for

all programs:

Program

Options Menu

Edge Module

Area Module
gray value fraction

Length Module

Circle Module

Light Module

Angle test
Angle Module

Edge search

Circle test

Length test

Test of

Gray value test

Pattern Module
Structure search

X OR Y position offset

X AND Y position offset

brightness offset

position tracking

position tracking

position tracking

position tracking

position tracking

position tracking

position tracking

brightness tracking

Modules should be
located in logical order.

Legend

Pattern Module
Structure search X AND Y position offsetposition tracking

option can be enabled in the module
saves offset for following modules

option can be enabled in the module
uses offset of preceding module

function / name
of module

Options need
enabling/disabling.
CAMAT 2 – 310.03.1999



Software Structure
2.2 CAMAT Program Structure

C A M A T R E F E R E N C E H A N D B O O K

2

Brightness

Tracking

Brightness tracking takes place by linking a Light module with the Area module:
• in the Light module, select the option: Brightness offset ( [Reference] button)
• in the Area module, activate the option: Brightness tracking ( [Relative] button)

Position Track-
ing

Position tracking in one direction
Position tracking in one direction takes place by linking an Edge module with the module
to be tracked:
• in the Edge module, select the option: Position offset ( [Reference] button)
• Position the Test window in the tracking direction
• In the following module to be tracked, active the option: Position tracking (deactivate

the [Fixed] button in the Window menu)

Position tracking in X- and Y-direction – Alternative 1: with Pattern
Module
Position tracking in the X- and Y-direction can be implemented by linking a Pattern module
with the module to be tracked:
• in the Pattern module, select the option: Position offset ( [Reference] button)
• in the following module to be tracked, activate the option: Position tracking (deactivate

the [Fixed] button in the Window menu)

Light Module
Gray value test brightness offset active

brightness tracking

Area Module
value fraction
Test of gray

Option activated

Option activated

position tracking

Option activated

Edge Module
Edge search X OR Y position offset

position changes
Module that tracks

Option activated

position tracking

Option activated

Pattern Module
Structure search X AND Y position offset

position changes
Module that tracks
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Position tracking in X- and Y-direction – Alternative 2: with two
Edge Modules
Position tracking in the X- and Y-direction can be implemented by linking two edge
modules with the module to be tracked:
• in the first Edge module, select the option: Position offset ( [Reference] button)
• Position the test window in the X-direction
• in the second Edge module, select the option: Position offset ( [Reference] button)
• Position the test window in the Y-direction
• in the following module to be tracked, activate the option: Position tracking (deactivate

the [Fixed] button in the Window menu)

position tracking

Option activated

X position offset active

position changes
Module that tracks

Edge Module 1
Edge search

Y position offset active

Edge Module 2
Edge search

Option B
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2.3 Run Mode and Edit

Mode
0

Screen in
Edit Mode

Edit mode:
• is the mode used for revising and producing programs and their settings
• can be started by canceling a program with the (Esc) button on the control device

The video display is divided into the following regions when in Edit mode:

1 Menu or controller

2 List or working area
This region displays either selection lists or a fixed video picture.

3 Display field
The window coordinates and their selected units are displayed:
3A …X-coordinate of the window origin
3B …Y-coordinate of the window origin
3C …X-size of the window
3D …Y-size of the window
3E …length unit specified during calibration

4 Results field for the module
The following information is displayed, depending on the module:
4A …the result(s): GOOD / BAD or numeric values
4B …the specified nominal value(s) of the module

12

3

3A 3B 3C 3D 3E 4A 4B

4
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Screen in
Run Mode

Run mode:
• is the mode used to execute the programs
• can be started with the [�Run] button from the Program menu
• is automatically active after switching on the CAMAT

In Run mode, the following elements are faded in with the test specimen:

1 Window of the processed modules
One window is allocated to each module. At the edge of each window there is the
sequence number of the associated module in the program. All windows of the pro-
gram can be faded in/out by using F1 on the control device.

2 Name of the program
3 Display of results

3A …Success/failure of each module is indicated by a circle system.
3B …Success/failure of the overall program is indicated by the right circle symbol.

1 2

3A 3B

Video display in Run mode
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2.4 Creating a Program

0

Initial Power-up
of CAMAT

During initial power-up there is no program stored in the CAMAT.
The following screen will appear:

Creating a
Program

framework

Create the program framework as follows:

1 Click on the [OK] button in the "Empty List" information field.
The information field will disappear. On the right you will see the Program menu, and
an empty program list on the left.

2 Highlight the [�New] button.

3 Press the (Enter) button.
The display will shift to the Module menu. A new program, consisting of the Picture
and Result modules, will appear in the module selection list.

4 If necessary, add additional modules.
See also item 8.

5 Click on [OK].

Module menuModule selection list
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6 Confirm the warning: "Save Program?" with [YES].
The display returns to the Program menu. The new program will be displayed in the
program list.

7 Use [�Save] to ensure a non-volatile saving of the program.
The program framework is thus complete and can be edited in subsequent steps.

8 Change/add modules, as described in Part 4 "Modules".
See also:
• Section 1.4 „Basic Procedures“
• Section 2.5 „Program Menu“
• Section 2.6 „Module Menu“

Program menuProgram list
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2.5 Program Menu

Overview
0

Use the Program menu to create, delete and edit programs.

A maximum of 15 programs with a maximum of 15 modules each (including picture record-
ing and results display) can be saved in the CAMAT.

Each program contains the following two modules (non-deletable)
• Picture module (picture recording) at program begin
• Result module (results display) at program end

Other modules can be inserted between these two modules.

The program list is displayed in the working area (left).

�Run Use [�Run] to start programs:

1 Click on [�Run].

2 Highlight the program.

3 Press (Enter).

See also Section 1.6 „Running the Programs“, subsection "Manual Start".

Options Menu

Program Menu

� Run
� Edit
� Save
� Clone
� New
� Delete
� Statist
� Options
� Info

Program
Selection List

Run Mode
Edit Mode / Module Menu
saves programs and configuration in Flash ROM
duplicates program
inserts new program
deletes program
displays/deletes statistics

program information
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�Edit Use [�Edit] to switch to the Module menu:

1 Click on [�Edit].

2 Highlight the program.
3 Press (Enter).

The Module menu will be displayed. Modules can be added/changed.

See also Sections:
• 1.5 „Editing the Programs“
• 2.6 „Module Menu“

�Save [�Save] will save the following settings permanently in the internal Flash ROM:
• current changes made to programs
• program-specific settings, such as the language
• setup settings, such as calibration factors and the defined dimensional units

�Clone Programs can be duplicated with [�Clone].

The duplicated program will be placed at the top of the program list.

�New New programs can be created with [�New].

New programs already contain two modules:
• the Picture module for recording a picture at the beginning of the program
• the Result module for displaying results at the end of the program

See also Section 2.4 „Creating a Program“.

�Delete Programs can be deleted with [�Delete]:

1 Click on [�Delete].

2 Highlight the program to be deleted.
3 Confirm your selection by pressing the [OK] button.

4 Confirm the displayed warning with [YES].
The program will be deleted.
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�Statist The Good/BAD statistics will be maintained across all test steps of the current program.

The statistics can be displayed and deleted in the Edit mode with [�Statist]. When starting
another program, the statistics will be reset to 0.

�Options [�Options] switches to the options menu.

See Section 3.1 „Options Menu“

�Info [�Info] displays the current software version in the CAMAT.
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2.6 Module Menu
0

Overview
0

�Edit A module in the current program can be edited with [�Edit].

1 Click on [�Edit].
The bar-cursor will switch to the module list.

2 Select the module to be changed by moving the cursor up/down.
3 Press (Enter).

The Editor will be opened for the module to be changed.
4 Edit and save the module.

�Add A module can be inserted into the current program with [�Add].

1 Click on [�Add].
The bar-cursor will switch to the module list.

2 Move the cursor up/down to the position below which the added module is to be inserted.
3 Press (Enter).

The list of insertable modules will be displayed.

Module Menu

� Edit
� Add
� Cut
� Copy
� Paste
� Delete
� Update

Cancel
OK

Module
Selection List

changes module in program
adds new module from list
cuts module from program
copies module into program
pastes copied/cut module
deletes module from program
tests module with current settings

confirms the action
cancels the action

Program Menu

Module
Editor Menus

Picture

Area
Angle
Circle
Edge
Length
Pattern
Result

Light
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4 Select the particular module by moving the cursor up/down.

5 Press (Enter).
The Editor of the inserted module will be opened.

6 Edit and save the module.

�Cut Use [�Cut] to place a module from the open program onto the clipboard. This will remove the
module from the program. The module can be re-inserted at any other position with [�Paste].

�Copy Use [�Copy] to place a module from the open program onto the clipboard. The module can be
re-inserted at any other position with [�Paste].

�Paste Use [�Paste] to insert a previously cut/copied module from the clipboard to another position
in the program.

�Delete Use [�Delete] to remove individual modules from a program.

1 Click on [�Delete].
The bar-cursor switches to the module list.

2 Select the module for deletion by moving the cursor up/down.
Picture and Result modules cannot be deleted.

3 Press (Enter).

4 Confirm the Warning: Delete module? with [YES].
The module will be deleted.
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�Update Use [�Update] to briefly test the individual modules. Error messages will be displayed.

[�Update] is identical with loading a program into the editor and subsequent pressing of the
[Test] button.

[�Update] must always be used when changes are made to the following modules:
• modules that determine the position or the position offset (Edge, Pattern)
• modules that determine the brightness offset (Light)
• the picture recording module (Picture)

OK button Always Save before leaving the Module menu, otherwise the changes will be lost.

1 Click on [OK].

2 Confirm the Warning: Save Program? with [YES]
Changes will be saved. The display switches to the Program menu.
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2.7 Window Menu

Overview

The window menu is nearly identical for all modules and for calibration (in the Options menu):

1 Adjust the position.

2 Adjust the size.

3 Adjust the direction.
4 Adjust the shape (square/circle).
5 Enable/disable the position tracking.

6 Save with [OK].

�Position Changes the position of the test window. The coordinates of the test window will be displayed
at the lower edge of the video picture.

Adjust the position
1 Highlight the [�Position] button.

2 Press (Enter).
The perimeter of the window is displayed by dashed lines.

3 Press cursor key on the control device.
The position will change.

4 Press (Enter).
The perimeter of the window will appear as a solid line.
The position is fixed.

�Size Changes the size of the test window. The dimensions of the test window are displayed at the
lower edge of the video picture.

Adjust the size
1 Highlight the [�Size] button.

2 Press (Enter).
The perimeter of the window is displayed by dashed lines.

3 Press the cursor key on the control device.
The size will change.

4 Press (Enter).
The perimeter of the window will appear as a solid line. The size is fixed.

Window
Menu

� Position
� Size

Circle

Fixed
Cancel

positions window

changes window size

changes window into circle

OK

fixes window in image
cancels action and returns to Module Editor

saves and returns to Module Editor

Direct. changes direct. of window
✓

✓
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Direct. Rotates the test window by a particular angle. The possible step size (45°/90°) depends on the
particular module.

Adjust the direction
1 Highlight the [Direct.] button.

2 Press (Enter).
The window changes direction.

3 Repeat step 2 as needed.
The direction is fixed.

Circle Use [ Circle] to create a circular test window. The default setting is a rectangular
window (❏).

The shape of the window can only be adjusted in the following modules:
• Light module
• Area module

Adjust shape
1 Highlight the [ Circle] button (✓).

2 Press (Enter).
The window will change shape.

See also Section 5.1 "Tips on Troubleshooting" in the display of circular windows.

Fixed Use [ Fixed] to switch the position tracking on or off. The default setting is: Position tracking
(❏).

Principle of position tracking
With the position tracking switched on, the program will use an internal, previously saved off-
set for tracking the change in position of the test object.

The offset can be created by Edge and Pattern modules if they are configured appropriately:
• Edge module …Offset in one coordinate direction
• Pattern module …Offset in X- and Y-direction

The advantage of position tracking: The window is always at the same position with respect to
the measured object, even if the location of the object changes within the picture.

Note:
Position tracking is always required for every new learning process. In the absence of
position tracking, errors can occur because objects are not found.

See also "Position tracking" in Section 2.2 „CAMAT Program Structure“.

Activate position tracking
1 Switch off [ Fixed] (❏).

2 Activate (✓) the [ Reference] button in the preceding Edge or Pattern module.
See Section 4.6 "Edge Module" and Section 4.8 "Pattern Module."

✓ ✓

✓

✓ ✓

✓

✓
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Deactivate position tracking / "Attach" window to video picture
1 Switch on [ Fixed] (✓).

„Attached Windows" are indicated by
a circle around the window midpoint
(see figures).

Type A: fixed
properties windows

Type B: fixed
search window

✓

CAMAT 2 – 18 10.03.1999



C A M A T R E F E R E N C E H A N D B O O K

Configuration 3
3
Configuration

0
0
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3.1 Options Menu

0

Overview
0

Flash [ Flash] is used to configure picture recording for calibration ONLY. The default setting
is active (✓).

Picture recording with Flash is characterized as follows (detailed information on request):
• Frame Integration mode
• Non-Interlaced Full-Picture recording

Note:
Compared to continuous lighting, the accuracy is roughly doubled with Flash.

Flash
Note:
Adjust the shutter on the lens so that no picture signal appears without flash.

1 Set [ Flash] button to active (✓).

2 Adjust the brightness of the flash source as needed.

No Flash
1 Set [ Flash] button to inactive (❏).

[�Shutter] is now available in the options menu.
2 Adjust the integration time with [�Shutter].

Options

Flash
�Shutter

Adjust

�Window
Unit

�Value
Calibr.

�Language
Cancel

enables/disables flash

confirms the action
cancels the action

Program Menu

Window
MenuMenu

OK

sets brightness (when Flash off)
live window for adjustment
configures measuring unit

sets dimension of calibration object

determines calibration factor
sets language

�Position
�Size

Direct.
Cancel
OK

positions window

changes window size
changes window direction

✓

✓ ✓

✓

✓
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�Shutter Use [�Shutter] to adjust the integration time for picture record-
ing with continuous lighting. The setting applies ONLY for cali-
bration when no flash is used.

Picture recording with continuous lighting is characterized as
follows (detailed information on request):
• Field Integration mode
• Interlaced Picture recording

Shutter Controller
The Shutter controller is used to set the integration time for
picture recording between level 0 and 9.

The brightness can be checked on the video picture.

Adjust [Adjust] opens a live picture window where the following steps can be performed:

Adjust the scene
1 Position the calibration element

At least 20% of the diagonals of the video picture should be filled by the calibration
element, otherwise an error message will appear.

2 Check the lighting and optimize the setting.
3 Adjust contrast of video picture on the CAMAT lens.

Record calibrated picture
4 Press (Enter).

The calibration picture with current settings for [ Flash] or [�Shutter] will be
recorded and then displayed in the operating area.

5 In the next step, the Unit will be specified. Continue with [Unit].

Unit Fundamentals
The Unit:
• is used for input of dimensions of the calibration element
• is the reference unit for determining the calibration factors
• is the dimensional unit for display of all length dimensions and their tolerances
• is displayed in the lower right of the Results field

If no dimensional unit is specified
The default setting in the lower right indicates "pixel." The [�Window], [�Value] and
[�Calibr.] buttons are (still) deactivated.

Level 0 1 2 3 4 5 6 7 8 9
Integration time
[ms] 20 10 8.3 8.0 4 2 1 0.5 0.25 0.1

brighter <<<<<<------------>>>>>> darker

✓
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Define the unit
1 Click on the [Unit] button until the desired dimensional unit is displayed in the lower

right. The (already known) width of the calibration element must be displayable in the
value range.
The following units are allowed:

2 In the next step, specify the calibration window. Continue with [�Window].

�Window Opens the Window menu.

1 Define the calibration window.
See Section 2.7 „Window Menu“. The central arrow in the calibration window denotes
the sensing direction for the calibration. The two sides of the calibration window paral-
lel to the sensing direction must each intersect the calibration element twice (see Fig-
ure).

2 In the next step, define the reference dimension. Continue with [�Value].

Unit Display
(lower rights)

Displayable value range Step size

pixel pixel No calibration is possible with this default setting.
nm 1.000 nm/pixel 0 …999,99 nm 0,01 nm
µm 1.000 µm/pixel 0 …999,99 µm 0,01 µm
m 1.000 m/pixel 0 …999,99 m 0,01 m
km 1.000 km/pixel 0 …999,99 km 0,01 km
µin 1.000 µin/pixel 0 …999,99 µin 0,01 µin
ths 1.000 ths/pixel 0 …999,99 ths 0,01 ths
mil 1.000 mil/pixel 0 …999,99 mil 0,01 mil
in 1.000 in/pixel 0 …999,99 in 0,01 in
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�Value Use [�Value] to adjust the precise (already known) dimension of the calibration element.

Relative to the dimensional unit specified as Unit, the hundreds, the one’s-position and the
hundredths can be adjusted with scales.

See also Type-C Slider in Section 1.3 „Control Elements and Conventions“.

Calib. Use [Calib.] to sense the calibration element and to compute and save the calibration factor in
CAMAT.

Calibration factor
The calibration factor (imaging scale) specifies how many picture points correspond to a par-
ticular object distance.

The measured distance is related to the reference distance set with [�Value].

Note:
The determined calibration factors must be saved with [�Save] in the Program menu,
otherwise they will be lost at the end of the current session.
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Perform calibration
1 Click on [Calib.].

The window will change and three points will be displayed. These points are used to mea-
sure the distance.

2 Check visually that the calibration element is precisely sensed.
3 Press [Enter).

The calibration factor will be calculated in CAMAT and displayed in the Result field.
4 Perform plausibility check.

Non-volatile Save of calibration results
To save the calibration result in the FlashROM:

1 Click [OK] to exit the Options menu and return to the Program menu.

2 In the Program menu, click on [�Save].
The calibration result will be available for all programs — even after CAMAT shuts down.

Recalibration
The CAMAT will have to be recalibrated in the following cases:
• when changing the measurement configuration
• when changing the lighting
• when changing the imaging optics
• if a new dimensional unit is used
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�Language You can change the language of the user interface with [�Language]:

1 Highlight the button with the appropriate language.

2 Press (Enter).
The highlighted button will be activated with (✓).

3 Click on [OK].
4 Click on [OK] to exit the Options menu to the Program menu.

5 Run any particular program with [�Run].
6 Use (Esc) to cancel this program again.

From this point on, all menus will appear in the new language.

Non-volatile Saving of Language Setting
To save the new language setting in the Flash-ROM:

1 Click on [OK] to exit the Options menu to the Program menu.

2 In the Program menu, click on [�Save].
The new language will now be available for all programs — even after a CAMAT shut down.
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4.1 Picture Module

0

Overview
0

The Picture module:
• performs the picture recording for the particular program
• moves the picture content into the CAMAT picture memory
• is included in every program and is located at the first position in the program
• can only be present once in a program
• can be modified, but not deleted

Live Picture The CAMAT live picture is displayed on the video monitor. It allows positioning of the test
scene within the CAMAT’s objective field.

Flash [ Flash] is used for configuring the picture recording for the program. The default setting
is enabled (✓).

Picture recording with flash is characterized as follows (detailed information on request):
• Frame Integration mode
• Non-Interlaced Full-Picture recording

Note:
Compared to continuous lighting, the accuracy is roughly doubled with Flash.

Picture Menu

Live
Flash

�Shutter
Display
Trigger
Test
Cancel
OK

live picture for adjustment

Module Menu

(Module Editor)

enables/disables flash
sets brightness (when Flash off)

enables/disables trigger input
tests module

cancels the action
saves

selects between storage picture mode and live picture mode

✓

✓

✓

✓ ✓
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Flash
Note:
Adjust the shutter on the lens so that no picture signal appears without flash.

1 Set [ Flash] button to enabled (✓).

2 Adjust the brightness of the picture source as needed.

No Flash
1 Set [ Flash] button to disabled (❏).

[�Shutter] is now available in the Picture module editor.

2 Adjust the integration time with [�Flash].

�Shutter Use [�Shutter] to adjust the exposure time for picture recording
with continuous lighting. The setting applies ONLY for calibra-
tion when no flash is used.

Picture recording with continuous lighting is characterized as
follows (detailed information on request):
• Field Integration mode
• Interlaced Picture recording

Shutter controller
The Shutter adjuster is used to set the integration time for pic-
ture recording between level 0 and 9.

The brightness can be checked on the video picture.

Display [ Display] switches between Live Picture mode and Memory Picture mode. The default
setting is Memory Picture mode (✓).

In Memory Picture mode:
• the recorded picture will be "frozen" until the next picture is recorded
• the picture display is slower roughly by a factor of four (4) than in the Live Picture mode

Additional picture fade-in can occur:
• Test windows and the program name can be faded on or out with the (F1) key.
• Results symbols can be faded on or out with the Result module

(see Section 4.9 „Result Module“).

Note:
For program control, use the Memory Picture mode and to run time-critical programs,
use Live Picture mode.

Trigger If [ Trigger] is enabled (✓) then a trigger signal is expected before the picture recording.
The default setting is disabled (❏).

The trigger signal must be connected to CAMAT Pin 1 and can come from a photoelectric
barrier. Triggering is possible both in Flash mode, as well as in Shutter mode.
See also Section 1.7 „Interfaces“.

✓

✓

Level 0 1 2 3 4 5 6 7 8 9
Integration time
[ms] 20 10 8.3 8.0 4 2 1 0.5 0.25 0.1

brighter <<<<<<------------>>>>>> darker

✓ ✓

✓ ✓
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Test Use [Test] to perform picture recording.

In Edit mode the created Memory picture can be used for configuring additional modules.

In Run mode, for each measuring cycle, a new picture will be recorded and then checked
and evaluated with the following modules of the program.
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4.2 Light Module
0
0

Overview

The Light module editor is used to:
• establish a medium, nominal brightness and associated tolerances
• save a brightness offset

The Light module:
• recognizes the average, actual brightness
• checks whether the determined, actual brightness is within the specified tolerance
• evaluates the result of the tolerance check
• can save the brightness discrepancy between nominal and actual brightness as a

brightness offset for brightness tracking of subsequent Area modules

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The following test windows are possible:
• rectangular
• round

The brightness distribution in the test window should be homogeneous; otherwise an error
will be displayed.

Light Menu

�Window
Referen.
Learn

�Toleran.
Test
Cancel
OK

Window
Menu(Module Editor)

saves brightness offset
learns nominal brightness

tests module
cancels the action

saves

�Position
�Size

Circle
Fixed
Cancel

positions window

changes window size
changes window in circle

OK

fixes window in imageadjusts nominal brightness + toler.

Module Menu

✓

✓

✓
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Reference The default setting for [ Referen.] is disabled (❏).

With the [ Referen.] enabled (✓) the determined discrepancy from the nominal bright-
ness can be used as brightness offset for any subsequent Area module. Thus, brightness
tracking of the scene is possible during changes in brightness.

The [ Relative] button of the Area module must also be enabled (✓).

See also "Brightness Tracking" in Section 2.2 „CAMAT Program Structure“.

Learn If all settings of the scene have been satisfactory, then click on the [Learn] button.
[Learn] accepts the determined, average gray value as a nominal gray value and automat-
ically sets the tolerances. The nominal gray value is located in the lower right corner of the
video picture after the [Learn].

The example: means that a nominal gray value of 133 gray scales
was found in the test window.

�Tolerance Use [�Toleran.] to display the nominal brightness and toler-
ances learned with [Learn] and use the shifters to change them.

Adjusted values
• Nominal brightness in gray values (0…255)
• upper/lower tolerances in gray values (0…255)

The standard tolerance used during learning is ±30 gray
scales.

Test Executes the module once for test purposes. The result (GOOD/BAD) is displayed in the
lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: The nominal brightness is present in the test window.
• BAD: The test window is brighter or darker than specified.

Examples When used for testing
• Lighting test: Lighting failed or additional sunlight is indicated as BAD
• Brightness test: Too dark or too bright test objects are indicated as BAD

When used for brightness tracking
• Brightness control: Saves a brightness offset for subsequent Area modules

{by enabling (✓) the [ Reference] button}

✓ ✓

✓

✓

✓
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4.3 Area Module
0

Overview

The Area module editor is used to:
• specify a gray value interval for the determination of area
• specify a nominal percentage of picture points of the test window whose brightness is

within a specified gray value interval (pixel counter)
• activate the brightness tracking

The Area module:
• determines the percentage surface area of picture points located within a particular

gray value interval
• performs a tolerance check
• evaluates the result of the tolerance check
• can use the brightness offset of a preceding Light module for brightness tracking

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The following test windows are possible:
• rectangular
• round

Area Menu

�Window
Relative

Learn
�Toleran.

Test
Cancel
OK

Window
Menu(Module Editor)

enables/disables brightness tracking
defines gray value range

adjusts nominal fraction + tolerances

cancels the action

saves

�Position
�Size

Cancel

positions window

changes window size
changes window in circle

OK

fixes window in imagelearns nom. fraction in gray value range

Module Menu

�Thresh.

tests module

Circle
Fixed

✓

✓

✓
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Relative The default setting of [ Relative] is disabled (❏).

With the enabled (✓) [ Relative] button, the brightness offset determined and saved in
the Light module can be used for the Area module. Thus it is possible to track the scene
during changes in brightness.

The [ Reference] button of the Light module processed before the Area module must
also be enabled (✓).

See also "Brightness Tracking" in Section 2.2 „CAMAT Program Structure“.

�Threshold Use [�Threshold] to adjust the permissible gray value interval. An inverse video display
should be used in the presence of test picture points. These points are shown bright in the
example.

Note:
The threshold is a value that must be input by the user as a required default setting
for the Learn command.

Adjusted values
• Nominal gray value (0…255)
• upper/lower tolerances in gray scales (0…255)

✓ ✓

✓

✓
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Learn [Learn] determines the percentage of picture points in the entire test window, whose gray
values belong to the gray value interval defined with [�Threshold].

This percentage will be saved as a nominal value (in %).

Picture points that are in the value range will be presented in reverse video. In the exam-
ple, these picture points are bright.

After the [Learn] command, the nominal value will appear in the lower right corner of the
video picture.

The example: means that 37% of the pixels of the test window
belong to the gray value interval defined with [�Threshold].

�Tolerance Use [�Tolerance] to display the percentage area and its toler-
ances, and use the shifters to change them.

Adjusted values
• Nominal area in %, which contains exclusively picture points

whose brightness is in the defined gray value interval.
• upper/lower tolerances for the area, in %
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Test Executes the module one time for test purposes. The result (GOOD/BAD) is displayed in

the lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: The portion of the test window specified with [�Tolerance] belongs to the

defined gray value interval.
• BAD: A larger or smaller portion of the test window than that specified with

[�Tolerance] belongs to the defined gray value interval.

Examples • Test for the presence of objects: If certain gray values are missing, then BAD will be
returned.

• Surface test: Check for bright or dark spots with brightness tracking (brightness offset
from the preceding Light module)

• Surface check of objects with a defined brightness: Breaks, pits, etc.
• Inspection: Check whether labels or printed tags are applied to surfaces.
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4.4 Angle Module

Overview

The Angle module editor is used:
• to specify a nominal angle and associated tolerances

The Angle module:
• specifies a line on the edge to be tested
• computes the angle between the specified line and the X-axis or Y-axis
• checks whether the determined angle is within the tolerance range
• evaluates the result of the tolerance test

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The search window:
• is rectangular
• can be rotated in 45°-increments

The search direction should be selected at a right angle to the tested edge.

Note:
The coordinate system is permanently assigned to the video picture. It is not depen-
dent on the rotational position of the search window.

Angle Menu

�Window
Y-Axis
Learn

�Toleran.
Test
Cancel
OK

Window
Menu(Module Editor)

sets reference axis (X or Y)
learns nominal angle

tests module
cancels the action
saves

�Position
�Size

Direct.

Cancel

positions window
changes window size
rotates window

OK

fixes window in imageadjusts nominal angle + tolerances

Module Menu

✓

Fixed✓
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Y-Axis The default setting of [ Y-Axis] is disabled (❏), so that the angle to the X-axis will be

determined.

If [ Y-Axis] is enabled (✓), then the angle to the Y-axis will be determined.

Note:
The X/Y-axes are permanently assigned to the video picture. If you change the
search direction by rotating the window, then the axes will not be rotated.

Learn [Learn] sets the angle speci-
fied in the memory picture as
the nominal angle and auto-
matically sets the tolerances.

The nominal angle (in °=
degrees) will appear in the
lower right corner of the
video picture after the [Learn].

The example: means that a nominal angle of 4° was determined.

�Tolerance Use [�Tolerance] to display and change the nominal angle
learned with [Learn] and its tolerances.

Adjusted angle
• nominal angle in °
• upper/lower tolerances for the angle deviation in °

During learning, a value of ±5° is used as standard
tolerance.

Test Executes the module one time for test purposes. The result (GOOD/BAD) is displayed in
the lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: Angle is within the tolerance
• BAD: Angle is not within the tolerance

Examples • Checking of labels for angled attachment to objects
• Check for angles on workpieces
• Sorting of various types of bottles by using the conical angle of the bottle’s neck

✓ ✓

✓
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4.5 Circle Module

Overview

The Circle module editor is used to specify:
• the sensing mode (interior/exterior)
• the sensing direction (left/up/right/down, in the Window menu)
• the nominal diameter (best circle) and associated tolerances
• the nominal eccentricity (roundness) and associated tolerances

The Circle module:
• determines the circular contour

The circular contour is defined as the best circle from the exterior and interior contour cir-
cle.

• determines the diameter of the default length unit
• determines the roundness (maximum eccentricity) in units of length

The roundness is defined as a tube around the best circle. The tube is defined by the inte-
rior and exterior contour circle.

• determines whether the diameter and the eccentricity are within the tolerance range
• evaluates the result of the tolerance check

Circle Menu

�Window
Inside
Learn

�Tol.Dia.

Test
Cancel
OK

Window
Menu(Module Editor)

sets radial search direction
learns nominal diameter/eccentricity

adjusts nom. eccentricity + tolerances

cancels the action
saves

�Position
�Size

Direct.

Cancel

positions window
changes window size
rotates window

OK

fixes window in imageadjusts nominal diameter + tolerances

Module Menu

�Tol.Ecc.
tests module

✓

Fixed✓

best circle

roundness

= Point
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�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The search window
• is rectangular
• can be rotated in 90°-increments

The search window should be placed around the circle contour.

Inside The first contour found in the search direction is determined in the Circle module. The search
direction is user-selected: Either from inside to outside, or from outside to inside.

The default setting is disabled (❏). and the sensing proceeds from the outer contour of the test
window to the midpoint.

[ Inside] should then be enabled (✓), if two nested circular contours (e.g., for valves or ball
bearings) are to be tested. The sensing takes place from the midpoint of the test window to
the outer contour.

Learn Use [Learn] to sense the circle and determine the contour.

[Learn] specifies the following nominal values and estab-
lishes the tolerances:
• Diameter of the best circle
• Eccentricity (roundness deviation)

The determined nominal values (best circle diameter,
eccentricity) are located in the lower right corner of the
video picture after the [Learn].

The example: means that a best
circle diameter of 0.502 mm and an eccentricity of 0.013 mm were found (with length
unit = mm).

�Tol.Dia. Use [�Tol.Dia.] to display the nominal diameter learned with [Learn]
and its tolerances, and change them with the controllers.ä nde rn

Adjusted values
• Nominal diameter in units of length
• upper/lower tolerances for the diameter

Learn uses ±10% of the nominal diameter as tolerances.

✓

✓
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�Tol.Ecc. Use [�Tol.Ecc.] to display the nominal eccentricity learned with
[Learn] and its tolerances, and change them with the shifters.ä ndern

Adjusted values
• Eccentricity in units of length
• upper/lower tolerances for the eccentricity in units of length

Test Executes the module one time for test purposes. The result (GOOD/BAD) is displayed in the
lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: Diameter and eccentricity are within the tolerance
• BAD: Diameter and/or eccentricity are not within the tolerance

Examples • Recognition of chips or dirt at the contour of drill holes:
• diameter of the inner contour circle is outside the tolerance
• best circle and outer contour circle are within the tolerance

• Recognition of cracks at the inner contour of holes:
• diameter of the outer contour circle is outside the tolerance
• best circle and inner contour circle are within the tolerance

• Check elliptical deviations on circular objects: Diameter of the inner and outer contour cir-
cle are outside the tolerance.

• Sorting of circular objects (coins, disks) based on the diameter
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4.6 Edge Module

0

Overview

The Edge module editor is used to determine:
• the nominal position of an edge and its associated tolerances
• a position offset perpendicular to the edge direction

The Edge module:
• determines the position of an edge
• checks whether the determined edge is within the tolerance
• evaluates the result of the tolerance check
• can save the result of the position deviation between nominal position and actual position

as a position offset for tracking the position of subsequent modules.

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The search window:
• is rectangular
• can be rotated in 90°-increments

The search direction should be selected at a right angle to the edge under test. The width
of the window determines how many parallel edge detections occur in the sensing direc-
tion. The edge position will only be accepted when within the test window.

Edge Menu

�Window

Learn
�Toleran.

Test
Cancel
OK

Window
Menu(Module Editor)

enables usage as reference
learns edge position

tests module
cancels the action
saves

�Position
�Size

Direct.

Cancel

positions window
changes window size
rotates window

OK

fixes window in imageadjusts edge position + tolerances

Module Menu

Fixed✓

Referen.✓
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Reference The default setting of [ Reference] is disabled (❏).

Use [ Reference] enabled (✓) to save the positional deviation of the Edge module as a posi-
tion offset and for tracking the position of subsequent modules.

The offset is determined only in one coordinate direction. If position tracking is required both
in the X-direction and in the Y-direction, then the Pattern module or an additional Edge module
should be used.

If position tracking is required for the subsequent modules, then the [ Fixed] button for the
subsequent modules must be disabled (❏) in the Window menu.

Learn Use [Learn] to sense the edges and to save the edge position, proceeding
from the base of the window in the sensing direction.

[Learn] defines the edge position determined in the memory picture in the
sensing direction as a nominal value and automatically specifies the toler-
ances. The nominal value (in the defined length unit) is located in the lower
right corner of the video picture after learning.

The example: means that the nominal value of 0.079 mm was deter-
mined (with length unit = mm).

�Tolerance

Use [�Tolerance] to display the edge position learned with [Learn] and its tolerances, and to
change them. The change in tolerances can be checked in the video picture: The tolerances
will be displayed by dashed lines in the video picture.

Adjusted values
• Edge position in units of length
• upper/lower tolerance for edge position in units of length

Test Executes the module one time for test purposes. The result (GOOD/BAD) will be displayed in
the lower right of the video picture.

Note:
We recommend you run [Test] before any save.

✓ ✓

✓

✓
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Result
• GOOD: found edge position is within the tolerance
• BAD: found edge position is not within the tolerance

Examples • Check the X-position of a label: Determine the left edge of the label
• Check the X-position of a printed tag within the label with additional position compensa-

tion:
• determine the left edge with the Edge module
• enable the position offset
• subsequent determination of the relative position of the printed tag with another Edge or
Pattern module (disable the [ Fixed] button in the search window)

• Check whether the correct label was applied
• Check a label for correct alignment
• Determine fill level in bottles
• Determine workplace size

✓
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4.7 Length Module
0

Overview

The Length module editor is used to determine:
• the shortest Euclidean distance between two physical edges and the associated tolerances

The Length module:
• determines the distance between two parallel edges
• checks whether the determined distance is within the tolerance
• evaluates the result of the tolerance check

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

The search window:
• is rectangular
• can be rotated in 90°-increments

The search direction should be selected at a right angle to the edges. The width of the
window determines how many parallel edges are recognized in the sensing direction. Only
edges within the test window will be accepted.

Length Menu

�Window
Learn

�Toleran.
Test
Cancel
OK

Window
Menu(Module Editor)

learns nominal length

tests module
cancels the action
saves

�Position
�Size

Direct.

Cancel

positions window
changes window size
rotates window

OK

fixes window in image
adjusts nominal length + tolerances

Module Menu

Fixed✓
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Learn Both edges can be determined with [Learn]. The window will

change and three points will be displayed. These points are used
to determine the length.

[Learn] accepts the determined length as nominal value and auto-
matically specifies the tolerances. The nominal value (in the
defined length unit) is located in the lower right corner of the
video picture after learning.

The example: means that a length of
0.315 mm was determined (for length unit = mm).

� Tolerance Use [�Tolerance] to display the nominal length learned with [Learn]
and its tolerances, and change them with the shifters.

Adjusted values
• Nominal length in units of length
• upper/lower tolerance in units of length

Test Executes the module one time for test purposes. The result (GOOD/BAD) is displayed in the
lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: determined length is within the tolerance
• BAD: determined length is not within the tolerance

Note:
In case of error (BAD) during the tests, increase the tolerances.

Example • Checking of lengths and spacing
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4.8 Pattern Module
0

Overview Pattern Menu

�Window

Learn

�Tol. Y
Test
Cancel
OK

Window
Menu(Module Editor)

enables usage as reference

tests module
cancels the action
saves

�Position
�Size

Cancel
OK

positions window
changes window size
fixes window in image

learns structure

Module Menu

�Pattern

�Tol. X

Pattern
Submenu

�P-Window

Coarse
Medium
Fine
Extra

Cancel
OK

P-Window
Menu
�Position

�Size
Cancel
OK

positions P-Window
changes size of P-Window
cancels

cancels
saves

saves

defines
quality
of
structure search

adjusts nom. position+toler. in X dir.
adjusts nom. position+toler. in Y dir.

�Thres.
defines percentage
of correspondance

Fixed✓

Referen.✓

✓

✓

✓

✓

Search windowPattern window
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The Pattern module editor is used to specify:
• the nominal position of a structure and its associated tolerances
• a position offset in X- and Y-direction

The Pattern module:
• determines the position of a structure
• checks whether the determined structure is in the tolerance range
• evaluates the result of the tolerance check
• can save the result of the position deviation between nominal position and actual position

as a location offset for tracking the position of subsequent modules.

�Window Opens the Window menu. See Section 2.7 „Window Menu“.

Search window and Pattern window
Search window and pattern window are rectangular.
• Pattern window is placed around the structure to be found again later
• Search window is placed around the pattern window.

The structure recognition only occurs in the search window. If Search window and Pattern win-
dow are the same size, then a standard Pattern matching occurs. In this case, the Pattern win-
dow will not track position changes of the object.

Position tracking
The Pattern window can only be tracked when the structure to be recognized is within the
search window.

Reference The default setting of [ Reference] is disabled (❏).

Use [ Reference] enabled (✓) to save the position deviation of the pattern module as a posi-
tion offset and for position tracking for subsequent modules.

The position offset contains the deviation in the X- and Y-direction.

If position tracking is required for subsequent modules, then the [ Fixed] button must be dis-
abled (❏) in the Window menu of the following modules.

�Pattern Use [�Pattern] to adjust the Pattern window and the search
parameters.

Search window Pattern window
(external) (internal)

✓ ✓

✓

✓
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�P-Window
The [�P-Window] button defines the Pattern window. Only the posi-
tion and size can be changed.

The structure to be determined must be within the Pattern window.

The position of the Pattern window will be displayed in the display
field (lower) during learning. See also Section 2.7 „Window Menu“.

�Threshold
Use [�Threshold] to determine the minimum amount of coincidence
of the checked and the learned structure (correlation). No previous
learning is required for this parameter. It is adjusted directly and must
be changed in case of erroneous testing.

The level of coincidence is not affected by the brightness in the test
window.

100% means complete coincidence, 0% means no coincidence. Use-
ful settings are 60…80%.

Rough / Medium / Fine

The precision of the search process can be selected with the following buttons:
• [ Rough] …Rough search, e.g., for a square or precision structure
• [ Medium] …Search for medium-fine structures
• [ Fine] …Fine search, e.g., for lettering or engraving

Only one of these buttons can be used.

Extra

After finding the structure with [ Rough], [ Medium] or [ Fine] the position of the struc-
ture can be searched again down to the particular picture point by using the [ Extra] button.

✓ ✓ ✓

✓

✓

✓

✓

✓ ✓ ✓

✓
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Strategy for adjusting the fineness

• For time-critical applications, always search first with [ Rough] function.
• If [ Rough] is not successful during [Test], instead of [ Rough] enable the [ Medium]

or [ Fine] button.
• If the accuracy is to be increased, additionally enable the [ Extra] button.

Learn Use [Learn] to sense the structure and to save the position of the structure relative to the ori-
gin of the search window.

[Learn] sets the determined position of the structure as the nominal position and automatically
sets the X- and Y-tolerances.

The nominal values (in the defined length unit) are located in the lower, right corner of the
video picture after the learning.

The example: means that the nominal values X = 0.049 and Y = 0.197
mm were determined (for length unit = mm).

�Tol. X
�Tol. Y

Use [�Tol. X] / [�Tol. Y] to display the
nominal positions of the structure in the X-
and Y-direction learned with [Learn] and to
change the tolerances with the shifters.

Adjusted values
• Nominal position in X-/Y-direction in

units of length
• Upper/lower tolerances for X-/Y-

direction in units of length

Special case: Checking for
presence of objects
If an object is to be checked merely to see
if it is present, then set the upper/lower tol-
erances for the X- and Y-direction to maxi-
mum/minimum values.

Function Sensitivity of
search Speed Comment Sketch

Rough Raster search,
8 picture points 16 × faster than fine Fastest, but least

accurate algorithm

Medium Raster search,
4 picture points 4 × faster than fine

Fine Raster search,
2 picture points –

Extra
Search with
picture-point
accuracy

Time added to
rough / medium /
fine

Condition: Previous search with
rough / medium / fine,
seeks structure in environment
of found position

✓ 8 × 8

✓ 4 × 4

✓ 2 × 2

✓ 1 × 1

✓

✓ ✓ ✓

✓

✓
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Test Executes the module one time for test purposes. The result (GOOD/BAD) is displayed in the
lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Result
• GOOD: found position is within the tolerance
• BAD: found position is not within the tolerance

Note:
In case of error (BAD) during the test, increase the upper tolerance.

Examples • Check for correct X/Y-position of a label: learning the lower left corner of the label as a
structure

• Check the X/Y-position of a printed text within a label, with supplemental position compen-
sation:
• determining the lower left corner of the label with the pattern module
• Enable Position offset
• subsequent determination of the relative position of the printed text with an additional
position module (enable [ Fixed] button in the search window)

• Determination of workpiece size
✓
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4.9 Result Module

0

Overview

The Result module editor is used:
• to specify the linkage of single results of the modules into an overall result
• to display single results and the overall result on the video terminal in Run mode

The Result module:
• generates an overall result from the single results
• controls the Results display on the video terminal
• controls the digital outputs as a function of the program result

�Logic The test results of the individual modules within a program can be logically linked with each
other in any way.

Logical Operands for Single Results of the Modules
The following, logical operands can be assigned to one module:
• + …the result must be Good
• – …the result must be Bad
• ? …result has no effect on overall result (IGNORE)

Result Menu

�Logic
Display
Test
Cancel
OK

(Module Editor)
defines logic assignments of results

tests module
cancels the action
saves

enables/disables display in the video image

Module Menu

✓

Legend Overall result Single results of the modules
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Logical operands for overall result of the program
The final, overall result can be output for each individual test object (= each test cycle) to the
digital outputs of the CAMAT:
• System O.K./Fatal error (Out 0)
• Good/bad (Out 2)

The outputs can control a PCL, for example.

The following, logical operands are assigned to the potential, overall results:
• + …Good
• – …Bad
• ! …fatal error, e.g., no lighting available.

Presentation of the overall results
Within a column:
• we find the operators for the single results of the modules of the program
• we find the operator for the overall result in the last line

The following rules apply to the overall result:
• If all single results of the modules correspond to the assigned operands, then the overall

results (stands at end of column) are output.
• If the first column does not correspond, then after coincidence in the columns, search far-

ther to the right and output the corresponding, overall result.
• If no column corresponds with the single results of the modules, then "bad" will be output.

Defining the initial, overall result (1st column)
1 Highlight [�Logic].

2 Press (Enter).
The cursor moves to the first operand of the first column.

3 Press (Middle key) of the control device until the desired logical operand for the single
result is displayed.

4 Press (Cursor down) key.
The cursor moves to the second operand of the first column.

5 Repeat steps 3 and 4 until the end of the column is reached.

6 Press (Enter).
The inputs will be saved.

Defining additional, overall results (additional columns)
1 Highlight [�Logic].

2 Press (Enter).
The cursor moves to the first operand of the first column.

3 Press (Cursor right).
The cursor moves to the first operand of a new column.

4 Define additional operators as described in the preceding section: “Defining the initial,
overall result (1st column)”.

5 Press (Enter).
The inputs will be saved.
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Digital outputs, Video picture fade-in and Overall Result
The defined, overall result will be output as follows when executing the module:

Displays Use [ Displays] button to fade in the single results of the modules and the overall result as
symbols on the bottom of the video display.

The default setting is enabled (✓). Thus for each module, its single result will be faded on as
a symbol. To the right of it – at some distance – the symbol will be faded on for the overall
result.

Note:
The display of the window and of the program name can be switched on/off in Run mode
with the (F1) key of the control device.

The result symbols are always faded on, regardless of the (F1) key of the control device,
when [ Displays] is enabled (✓).

Test Executes the module one time for test purposes. The result (GOOD/BAD) will be displayed in
the lower right of the video picture.

Note:
We recommend you run [Test] before any save.

Output signals Overall result in
Result menu

Signal Pin No. + – !

Out0 4 1 1 0
Out2 2 1 0 0

Overall result GOOD BAD Fatal
error

Video picture symbol of overall result

✓ ✓

bad

good

Single module Overall result (see also table: Digital outputs

– or !

+

and overall result)

✓
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5.1 Tips on Troubleshooting

Programs or
Modules are

Lost after Shut
down

Changes to modules or changes to the configuration must ALWAYS be saved separately:

1 when exiting the editor of the particular module (save the module)

2 when exiting the Module menu (save the edited program)
3 in the Program menu (non-volatile save of programs and configurations in the Flash-ROM)

If one of these steps is omitted, then inputs can be lost.

CAMAT does
not record

pictures

New pictures are recorded as follows during editing:

1 Click the Live button on the Picture Module Editor.

2 Adjust the picture.
3 Click the [Test] button on the Picture Module Editor.

Where to adjust
the tolerances?

• Tolerances can be adjusted with the two outer slider tabs in the Adjustment menu.
• The middle shifter is used to adjust the nominal value and changes the tolerances propor-

tionately.
• If the nominal value is changed, then the value previously learned with [Learn] will also

change.
• Special case, Pattern module: Tolerances are separately adjustable for the X- and Y-direc-

tions.

Circular window
not displayed

To save computation time, defined circular windows in the Window menu (e.g., in the Area
module) are displayed as rectangles in the program. This rectangle pertains only to the mon-
itor display. The actual calculation and evaluation always pertains to the circular window.

Control device
does not work

Make sure that the cable is not damaged (inspect it). A reference list of possible replacement
cables is available from the manufacturer.

Do not open the control device! The control device does not contain any batteries that have to
be replaced.

Monitor picture
is cut

Several video monitors will display only about 95% of the video image. This is not sufficient
for the CAMAT. Suitable monitor models can be obtained from your system manufacturer.
Underscan monitors are also suitable.
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5.2 Index

A
Activating position tracking 2-17
Adding a new module 2-13

Adjustment of the calibration element in
the picture 3-3

Angle in Angle module 4-12
Angle module 4-11
Area in Area module 4-9

Area module 4-7

B
Bad result 4-26

Basic procedures 1-8
Brightness setting in Light module 4-6
Brightness Tracking, linking 2-4

C
Cables 1-17
Calibration picture 3-3

Calibration unit 3-3
Circle module 4-13
Cloning a program 2-11

Configuration 1-10
Continuous lighting 4-3
Control unit 1-5

Copying a module 2-14
Creating a new program 2-11
Creating a program 1-10

Cursor buttons of the control unit 1-5
Cutting a module 2-14

D
Deleting a module 2-14
Deleting a program 2-11

Dialog buttons 1-6
Diameter in Circle module 4-14
Direction of the search window 2-17

Display live picture 4-2
Display, switching of picture recording

mode 4-3

E
Eccentricity in Circle module 4-15

Edge in Edge module 4-17
Edge module 4-16
Edit mode 2-6

Editing a module 1-8, 2-13
Editing a program 1-8
Editing programs 2-11

Evaluation of programs 1-11
Evaluation of the program 4-26
External initiator (PLC), program start

1-12

F
Flash, picture recording 4-2
Function overview of the modules 1-4

G
Good result 4-26
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I
Info 2-12

Inside, Sensing direction in Circle module
4-14

Interfaces 1-14

L
Language setting 3-7

Length in Length module 4-20
Length module 4-19
Light module 4-5

Live Picture mode 4-3
Logical linking of single results 4-26

M
Manual program start 1-12
Memory Picture mode 4-3
Menu structure 2-2

Module list 1-4
Module menu 2-13
Modules 1-4, 1-10, 4-1

O
OK button, Saving modules 2-15
Operating conditions 1-19

Optimizing of programs 1-11
Options menu 3-2
Overall result (of the program) 4-27

P
Pasting a module 2-14

Pattern menu in Pattern module 4-22
Pattern module 4-21
Picture module 2-11, 4-2

Picture recording 1-10
Position tracking 4-22

linking 2-4
reference 4-17

Power-up of CAMAT 2-8
Precision of the search process in Pattern

menu of Pattern module 4-23
Program 1-4
Program list 1-13

Program menu 2-10
Program start 1-12
Program structure 2-3, 2-8

R
Recalibration 3-6
Reference

for position tracking in Edge module
4-17
Reference Handbook 1-2
value in calibration element 3-5

Result module 2-11, 4-26

Result output 4-27
Run mode 2-6

S
Safety instructions iii
Saving programs and configuration 1-9
Search window position 2-16

Sensing direction in Circle module 4-14
Shutter, picture recording 4-3
Size of the search window 2-16

Slider tabs 1-6
Start 1-12
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T
Technical data 1-19

Testing of programs 1-11
Threshold in Area module 4-8

U
Updating modules 2-15

W
Window in Options menu 3-4

Window menu 2-16

X
X-Axis

in Edge module 4-17
pattern position in Pattern menu 4-24

Y
Y-Axis

in Edge module 4-17
pattern position in Pattern menu 4-24
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5.3 Glossary

0

Term Explanation
Actual value During processing of a ➟ module, the comparison of actual values

of the parameters with the default ➟ nominal values and ➟ toler-
ances will yield the ➟ single result

BAD Test result: Not okay

Brightness offset Deviation in average brightness measured in the test process and
saved internally in the ➟ test window compared to the learned,
nominal brightness; used for ➟ brightness tracking

Brightness tracking Compensation of brightness changes in the ➟ scene

Calibration Calibration in the CAMAT uses the calibration element.

Cloning Duplicating of programs

Edit mode Mode in which programs can be edited; ➟ Run mode

Externally started
program

One of the programs with the six smallest numbers in the Program
Names can be selected by an external ➟ initiator and started.

Field Integration mode Picture recording method using continuous lighting

Frame Integration mode Picture recording method using flash

GOOD Test result: Okay

Gray value interval Range of gray values between an upper and lower ➟ tolerance

Initiator e.g., a PLC whose outputs control the program processing in
CAMAT

Live picture Current picture on the picture sensor; ➟ memory picture

Live picture mode Fast Run mode for program where the ➟ memory picture, the Win-
dows and the program name are not faded in; ➟ memory picture
mode

Memory picture Picture saved by ➟ Picture recording in the CAMAT;➟ Live
picture

Memory picture mode Mode for picture recording in which the ➟ Memory picture, the Win-
dows and the program name are faded on for the duration of a pro-
gram run: This mode is about four (4) times slower than the ➟ Live
picture mode

Module Basic structure of ➟ programs; measuring task that can be interac-
tively configured for a particular measuring task

Module list List where the modules can be selected

Nominal value The reference value of a parameter adjusted in the ➟ Edit mode
based on the optimal setting of the ➟ scene

Overall result Overall result of the ➟ program

Overlay picture Overlay picture of the ➟ memory picture which contains windows,
text and symbols (Good/bad)

Pattern Window Adjustable Window for structure recognition in the Pattern module
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Picture memory Memory area in the CAMAT to save the ➟ memory picture during
the ➟ picture recording

Picture point Smallest surface object of the memory picture with unique gray
value

Picture recording Saving a video picture in the ➟ picture memory ➟ memory picture

Position offset Deviation of the position of a specimen measured in the test pro-
cess and saved internally, with respect to the nominal position;
used for ➟ position tracking

Position tracking Compensation of position deviations of the ➟ scene

Program Sequence of randomly arranged ➟ modules that are cyclically pro-
cessed in the CAMAT

Program list List in which the programs can be selected

Program structure Minimal program consisting of Picture module and Result module

Run mode Mode in which a program is processed. ➟ Edit mode

Scene Total of all factors affecting the test process, such as optical imag-
ing, lighting, technological process

Session Time between the switch on and switch off of the CAMAT

Session Time between the switch on and switch off of the CAMAT

Single result Result of a ➟ module

Slider Controller with 1-3 sliding tabs for editing of parameters in CAMAT

Test window Adjustable window for modules in which the module is active, or a
➟ position tracking / ➟ brightness tracking is possible

Tolerance The permissible limit values of a parameter adjusted in the ➟ Edit
mode based on the optimum setting of the ➟ Scene

Term Explanation
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